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Overview

In this DIY project, we'll show you how to 3D print a Daft Punk helmet with Bluetooth
controlled NeoPixel LEDs! You can use your smartphone or smartwatch to trigger
animations and even change the colors of the NeoPixel LEDs with the Adafruit
Bluefruit LE Connect app on Apple App Store (https://adafru.it/ddu) or Google Play
Store (https://adafru.it/f4G).

In a previous project we made Guy-Manuel’s helmet and 3D printed it in just one
piece. This time around we wanted to make Thomas Bangalter’s helmet but this time
we wanted to make it lighter, have the ability to see through it and even apply some
finishing techniques.
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Parts List

Below is a list of parts used in this project.

2 x Adafruit NeoPixel Ring 24x (http://adafru.it/1586)
Adafruit Feather 32u4 Bluefruit (http://adafru.it/2829)
Adafruit NeoPixel Strip (http://adafru.it/1461)
5V Adafruit Trinket (http://adafru.it/1501)
2 x Slide Switch (http://adafru.it/805)
2 x JST extension cables (http://adafru.it/1131)
2000 mAh Lithium Battery (http://adafru.it/2011)
2500 mAh Lithium Battery (http://adafru.it/328)

Tools & Supplies

Here's a list of tools used to get this project completed. If you don't have access to a
3D printer, you can send your parts to 3DHubs.com (https://adafru.it/iNA) to have them
printed and shipped to you.

3D Printer (http://adafru.it/2412) (A Big One!)
PLA or ABS Filament (http://adafru.it/2080)
NinjaFlex Filament (http://adafru.it/1690)
Flush cutter (http://adafru.it/152)
Wire Stripper (http://adafru.it/527)
Silicone wire (http://adafru.it/2003)
Panavise Jr. (http://adafru.it/151)
Helping Third Hands (http://adafru.it/291)
5-3/4 Inch x1/4 Inch x3/32 Inch Wood Craft Sticks (https://adafru.it/knD)
2.4mm (.093 in.) thick tinted Acrylic sheet (https://adafru.it/Cwv)

Light Painting with Daftpunk

Have fun with light painting photography!  

• 
• 
• 
• 
• 
• 
• 
• 

• 
• 
• 
• 
• 
• 
• 
• 
• 
• 
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Shoot lazers from your eyes and ears!

Look _Amazing_ while you travel "Around The World"!

Lighter, Faster, Stronger!

Although this design looks very similar to Thomas Bangalter's Daftpunk helmet, it's
not 100% accurate. There are some slight differences. Having said that, it is however
light in weight, wearable and you can actually see through it!
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Project Expectations 

This is a bit of an advanced endeavor and not well suited for a first time 3D printing +
electronics project. The challenging portion of this project is the finishing techniques
as it requires lots of time and elbow grease to sand, sand and sand some more! It
requires a large working space, with well ventilation. 3D printing the parts "as is"
requires a fairly large printing area (305mm cubed, ideally).

©Adafruit Industries Page 8 of 40



Circuit Diagram
Electronics

The circuitry is divided into two main sections - The ears and the visor. In this project
we're using two micro-controllers and two lithium polymer batteries. This gives a
longer "play-time" but makes the total cost a bit higher. Follow the two circuit
diagrams below and reference the connections for wiring the circuit.

NeoPixel Ring (Ears) circuit

Trinket 5V and 24x NeoPixel rings

GND and BAT pins from the Trinket connects to GND and PWR pins and the NeoPixel
rings. Pin #0 from the Trinket connects to Data Input on the 24x NeoPixel Rings. The
two 24x NeoPixel rings shared Data, Power and Ground connections via a Y-cable.

The pads on the back of the Trinket connect to a female connector of a JST extension
cable. The the red wire  from the JST extension cable connects to the +Postive pad
and black wire connects to the -Negative pad on the Trinket.

A slide switch is spliced in between a second JST extension cable.

The female connector on the second JST extension cable connects a the male part of
the JST extension cable that's wired to the back of the Trinket.

The male connector from lipo battery connects to the female connector on the JST
extension cable.
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The male connector from lipo battery connects to the female connector on the JST
extension cable.

Adafruit Feather 32u4 Bluefruit LE circuit

One long NeoPixel strip is cut in half to make two strands of NeoPixel strips that will
go across the visor.

The two NeoPixel strips are connected power to power, ground to ground, and data
out to data in - follow the arrow icon on the strip to indicate the correct direction of
the strip.

The first NeoPixel's data input will connect to Pin #6 on the Adafruit Feather 32u4
Bluefruit LE. 5V power from the NeoPixel strip will connect to the BAT pin on the
Adafruit Feather 32u4 Bluefruit LE.

The ground pin from the NeoPixel strip will connect to the ground pin on the Adafruit
Feather 32u4 Bluefruit LE.

A slide switch will splice in between the positive red wire of a JST extension cable.
The female connector plugs into the male connector of the lipo battery while the male
connector plugs into the JST connector of the Adafruit Feather 32u4 Bluefruit LE.
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Lithium Battery Charger

Adafruit Feather 32u4 Bluefruit LE has a built-in USB battery charging circuit. Plug in a
microUSB cable into the microUSB port on the Adafruit Feather 32u4 Bluefruit LE to
recharge the lipo battery using a USB adapter from a wall outlet or your computer.

Code
Arduino Libraries

To use the Daftpunk BLE sketch you'll want to make sure you're using the latest
version of the Arduino IDE (https://adafru.it/fvm) (1.6.5 at the time of this writing).

If you're totally new to Arduino take a little time to go through some introductory
tutorials like how to make a LED blink (https://adafru.it/iqd).  This will help you
understand how to use the IDE, load a sketch, and upload code.

Next you'll need to make sure the libraries used by the sketch are installed.  With the
latest Arduino IDE you can use its library manager (https://adafru.it/fCN) to easily
install libraries, or check out this guide on how to manually install a library (https://
adafru.it/dNR).  You'll want to install the following libraries:

Adafruit BluefruitLE nRF51 (https://adafru.it/19Ya)
Adafruit NeoPixel (https://adafru.it/aZU)

Search for the libraries in the library manager and they should be easy to find and
install.

Adafruit AVR Boards

Next, you'll need to install the Adafruit AVR boards package from the Boards
Manager. Open the Boards Manager and search for Adafruit AVR. This includes all of
the boards from Adafruit and will make Arduino compatabile with them. The Daftpunk
BLE sketch was tested with version 1.4.0.

Uploading Sketch to Adafruit Feather BLE

This sketch will run the Bluetooth controlled LED program to the NeoPixel strips that
are mounted to the front of the visor.

• 
• 

©Adafruit Industries Page 11 of 40

https://www.arduino.cc/en/Main/Software
https://www.arduino.cc/en/Main/Software
file:///home/adafruit-arduino-lesson-1-blink
https://www.arduino.cc/en/Guide/Libraries#toc3
file:///home/adafruit-all-about-arduino-libraries-install-use/arduino-libraries
https://github.com/adafruit/Adafruit_BluefruitLE_nRF51/tree/master
https://github.com/adafruit/Adafruit_BluefruitLE_nRF51/tree/master
https://github.com/adafruit/Adafruit_NeoPixel
https://github.com/adafruit/Adafruit_NeoPixel


To load the sketch make sure the libraries above are installed, and the Arduino is
connected to the computer through a USB cable.  Under the Tools -> Board menu
make sure the Adafruit Feather 32u4 is selected, and under the Tools -> Port menu
the serial port for the Adafruit Feather is selected.  

Then press the upload button or click the Sketch -> Upload item to send the code to
the Arduino.  Woo-hoo the sketch should be running.

feather_bluefruit_neopixel_animation_controller.zip
https://adafru.it/kpA

Connect Adafruit BLE Mobile App to Adafruit Feather BLE

Download the Adafruit BLE Connect app for iOS or Android. Under the peripherals
list, tap the connect button on the Adafruit Bluefruit LE item. Make sure the Feather
board is powered on. Select "Controller" and choose either Control Pad or the Color
Picker.

Adafruit Bluefruit LE Connect for iOS (https://adafru.it/ddu)
Adafruit Bluefruit LE Connect for Android (https://adafru.it/f4G)

Control Pad

Buttons 1-4 will trigger an animation.

larsonScanner
color wipe
rainbow gradient
rainbow cycle

Color Picker

Here you can change the brightness or RGB value of the leds. 

Uploading Sketch to Adaruit 5V Trinket

If you like to power the NeoPixel Rings separately from the NeoPixel strips in the
visor, you can use a separate sketch that's included with the Adafruit NeoPixel Library:
strandtest.

• 
• 

1. 
2. 
3. 
4. 
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It's been slightly modified to only loop through the rainbwCycle animation.

To upload the sketch to the Adafruit 5V Trinket, select Adafruit Trinket 16MHz from
the Boards option under the Tools menu. Then, choose the USBtinyISP option under 
Programmer in the Tools menu. Be sure a USB cable is plugged into the 5V Trinket
and your computer. When the red LED pulses on the Trinket, hit the upload button. It
should upload then the sketch.

#include &lt;Adafruit_NeoPixel.h&gt;
#ifdef __AVR__
  #include &lt;avr/power.h&gt;
#endif

#define PIN 0

// Parameter 1 = number of pixels in strip
// Parameter 2 = Arduino pin number (most are valid)
// Parameter 3 = pixel type flags, add together as needed:
//   NEO_KHZ800  800 KHz bitstream (most NeoPixel products w/WS2812 LEDs)
//   NEO_KHZ400  400 KHz (classic 'v1' (not v2) FLORA pixels, WS2811 drivers)
//   NEO_GRB     Pixels are wired for GRB bitstream (most NeoPixel products)
//   NEO_RGB     Pixels are wired for RGB bitstream (v1 FLORA pixels, not v2)
Adafruit_NeoPixel strip = Adafruit_NeoPixel(60, PIN, NEO_GRB + NEO_KHZ800);

// IMPORTANT: To reduce NeoPixel burnout risk, add 1000 uF capacitor across
// pixel power leads, add 300 - 500 Ohm resistor on first pixel's data input
// and minimize distance between Arduino and first pixel.  Avoid connecting
// on a live circuit...if you must, connect GND first.

void setup() {
  // This is for Trinket 5V 16MHz, you can remove these three lines if you are not 
using a Trinket
  #if defined (__AVR_ATtiny85__)
    if (F_CPU == 16000000) clock_prescale_set(clock_div_1);
  #endif
  // End of trinket special code

  strip.begin();
  strip.show(); // Initialize all pixels to 'off'
}

void loop() {
  rainbowCycle(10);
}

// Slightly different, this makes the rainbow equally distributed throughout
void rainbowCycle(uint8_t wait) {
  uint16_t i, j;

  for(j=0; j&lt;256*5; j++) { // 5 cycles of all colors on wheel
    for(i=0; i&lt; strip.numPixels(); i++) {
      strip.setPixelColor(i, Wheel(((i * 256 / strip.numPixels()) + j) &amp; 255));
    }
    strip.show();
    delay(wait);
  }
}
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Upload and Test Circuit

Once the code is uploaded to the micro-controllers, its a good idea to protoptype the
circuit using the diagram in the previous page. Test the NeoPixel Strip and a single
NeoPixel Ring to ensure the components are functional. Try out the Adafruit Feather
32u4 Bluefruit LE and run the Adafruit Bluefruit LE Connect iOS/Android app. Play
with the controls and use the color picker to change the colors of the NeoPixels.

3D Printing
3D Printed Pieces

Thomas' Daftpunk helmet is split into three main pieces. The top, middle and bottom
parts. The parts will need to be glued together using adhesives. These pieces feature
pockets that allow wooden craft sticks to be inserted into them - This aligns the parts
together and holds them in place while the glue sets.

Filament Materials

We recommend using PLA material to reduce wraping while 3D printing. The
parts can be printed in different types of filament, such as ABS, PET or Nylon.

Download STLs
https://adafru.it/kpB
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Slicer Settings

To slice the parts, we used Simplify3D. We recommend using the settings below or
use them as reference. We 3D printed these parts on a Type A Machines Series 1 3D
printer. If you have Simplify3D, you can download our profiles below.

Download Printer Profiles
https://adafru.it/ikd

Tolerances

The pocket areas of the parts may have tight tolerances. Test the tolerances by
inserting a wood craft stick into each pocket. If sticks will not fit into the pockets, you
may need to use a craft knife or filing tool to open up the area.

daftThomas-top.stl

daftThomas-mid.stl

daftThomas-btm.stl

220c extruder
90mm/s print speed
120mm/s travel speed
No supports 

top part takes about 7 hours

middle part takes about 9 hours

bottom part takes about 7 hours

daftThomas-shadesC.stl – visor template

lipoPocket2000.stl
Ninjaflex
230c
30/45mm/s speeds

Battery holder for 2000mAh
battery

lipoPocket2500.stl
Ninjaflex
230c
30/45mm/s speeds

Battery holder for 2500mAh
battery
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Bed Leveling

Any parts with large surface require a well leveled build plate. If your 3D printer
features a heated bed, set it to 60c to minimize warping. Blue tapers tape, build tak,
and sticky adhesives can help keep your part flat and adhere to the bed. You can
optionally use a brim to help hold the part to the bed.

Head Size

The helmet was designed to fit a hat size of 7" 3/8. It's roomy, with enough space for
electronics and even fits a head wearing glasses.

Customize The Design

The parts where designed in Autodesk Fusion 360. The design has been made
public, and available to download in different formats. If you'd like to use a different
CAD software package, you are free to import the files and remix them.

Edit Design
https://adafru.it/19Yb

Assembly
Join The Three Pieces

After the parts have been 3D printed, we'll need to join them together using wooden
craft sticks and apply glue to permanently bond the parts together.
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Wooden Craft Sticks

In this project, we're using wooden craft sticks with the following measurement 

5-3/4 Inch x1/4 Inch x3/32 Inch

To measure them to the appropriate lengths, let's start by insert them into each
pocket. The depth of the pocket can be used to measure the length - Use a pen to
mark on the stick. Double the length of one depth to get the necessary length of the
stick. Cut the wooden stick using scissors or wire cutters. You'll need to do this
several times, for each group of pockets.

Dry Run Parts

Now that the craft sticks are measured and cut to length, do a dry run test fitting and
see if the you can join the parts togeher. If there's a gap between the parts, try to trim
the craft sticks shorter, or widen the pockets with a filing tool or craft knife.

• 

Be careful not to break the stick while inserting into the pocket.
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Glue Parts Together

Now that we have the sticks measured and cut to the appropriate lengths, let's glue
to the parts togeher. 

We recommend using silicone-based adhesives, such as E6000. Remove the sticks
from the pockets and apply a small amount of E6000 into each slot. Then, insert the
sticks back into the pockets.

Add another small amount of glue to the craft sticks and then join the parts together.
E6000 has about 4 minutes of tack time, thats how much time you have to join the
parts before it becomes tacky.
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Joining Parts Together

Slow stack the parts on top of each other. If any excess glue appears, wipe it away
any with a paper napkin. You need to let the glue set for a few hours before
proceeding with the rest of the build.

Joining Seams from top front

You may need to join the seam together to close any gaps in the top front of the
helmet. We recommend using super glue to bond these seams together.

Apply a small amount of super glue near the top part of the ears. The corner of the
outter visor may also has gaps. You may need to apply pressure and hold the parts
closed together while the super glue sets in. Ensure the parts are aligned properly.
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Joining Seam from bottom corners

Once the top of the corners are dry, we can join the bottom part of the helmet
together. Use the same super gluing technique to join these seams together. 

Let glue fully cure

Allow the adhesives about a half hour to cure. 

Building the acrylic visor

The visor is built using a pre tinted acrylic sheet. Leave the protective film on the
acrylic sheet until the very end of the build. 3D print the visor template. We'll use this
as a reference.
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Trace visor template

Lay the 3D printed visor template flat on a lower corner of the acrylic sheet. Mark an
outline of the visor template using a pen.

Score acrylic sheet

Next we need to score out the outline of the template. You’ll need a straight edge and
scoring tool. Trace the outline several times with the scoring tool, using the straight
edge to keep the lines nice and straight. Flip over the acrylic sheet and repeat
scoring on the backside. Keep scoring until you feel the cuts are deep enough.
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Snap Part from Sheet

Move the acrylic sheet near the edge of the table. Using your hand, apply a bit of
pressure to the traced out part and snap the piece off the sheet. If it doesn’t snap off
with a bit of pressure, continue scoring the outline.

Bending the visor to shape

Now we need to bend the acrylic piece. To do this, we’ll use a heat gun. A PanaVise
or vice tool can help hold the heat gun upright while we apply heat to the acrylic.
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Heat up acrylic visor

Using both hands, hold it over the airflow. We recommend wearing heat resistant
gloves to avoid any potential burns. Move the acrylic from side to side. You’ll feel the
acrylic become soft. Lightly bend the part to create a curvature. Use the helmet to
reference the curvature.

Test fit visor

Once you’ve bent the acrylic piece, try fitting the part inside the helmet to do test fit. If
its curvature doesn’t match the helmet, reapply heat and bend it until they match.

Be careful not to snap the visor in half while test fitting! Too much pressure will 
break the acrylic.
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Finishing

Power Sander

Next up we’re going to do some finishing techniques to smooth out the surface and
make it shinny and metallic looking. In this project, we used a power sander to help
speed up the process. A power sander with detail tip allows you to get into crevices.
We recommend starting off with a low grit, like 120 and gradually moving up to a fine
grip, like 220.
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Sanding details 

The details in between the ears require detailed sanding. Make sure to get in the
crevices and smooth out the builds lines. Sand across the entire surface of the
helmet, blending the build lines. Be sure to do this in a well ventilated area and wear
a breathing mask and proper eye protection.

Filling gaps with XTC-3D

Once we’ve sanded the helmet down, we can apply epoxy resin coating to fill in any
gaps. XTC-3D coating from Smooth-On is great for this. It’s a two part solution with a
2:1 ratio mix. We recommend using half of the provided cup. It has a work time of
about 10 minutes. We can extend the work time to about 15 minutes by pouring the
mix into a aluminum foil tray.
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Mixing XTC-3D

We recommend using a foam/sponge brush to apple the resin onto the surface. Mix
the two parts in the aluminum tray. It’s a good idea to have a few foam brushes on
hand as they’re only good for one time and not reusable.

Apply XTC-3D

We recommend resting the helmet on top of a sturdy bottle, jug or other type of liquid
container while applying the resin coating. Wearing nitrilite gloves is a good idea, you
don’t want to get any resin on your skin! Avoid applying an excessive amount of
XTC-3D. If you apply too much, it’ll start to drip. Apply an even coat across the whole
surface. Soak up any excess that may build up near the bottom or crevices.

Drying

Rotate the helmet and use lighting to see if there’s any missed areas or uneven brush
strokes. Avoid smudging the coating by handling the bottom edges of the helmet.
Allow the XTC-3D coating at least hour hours to cure. If the helmet feels tacky after
four hours, allow it another hour or so until it’s completely hardened.

More Sanding!

Once the epoxy resin has fully cured, it’ll be very shiny and hard. Now we need to
sand the surface again. Let’s use a finer grit sand paper, like 220. Sand down the
entire surface. Of course, do this in a well ventilated area, wear a breathing mask and
eye protection. Even out the surface until it’s nice and smooth.

©Adafruit Industries Page 26 of 40



Here’s where the time consuming part comes into place. Apply a second coat of
XTC-3D coating and sand it yet again. You may want to take a break in between these
two coating / sanding sessions. It’s a lot of work!

Primer Filler

OK, Once we've sanded the XTC-3D coating a second time, we can cover the surface
with primer filler spray paint. This helps even out the surface and fill in any remaining
gaps / build lines. Rest the helmet on a bamboo stack or similar while applying the
spray paint. You may need two cans of primer filler to cover the entire helmet.

Apply Primer Filler

Remember to do this in a well ventilated area, wear a proper breathing mask, proper
eye wear and gloves  while spray painting. Try not to apply too much spray paint. A
light coat will be suffice. Allow the paint to dry for 30 minutes.
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Sand Primer Filler

Are you tired of sanding yet? This should be the last session of sanding! After this, it
should be pretty darn smooth, like a babies bottom! This time, let’s use a fine grip of
sand paper, like 220. Smooth out the entire helmet. Sanding down the primer filler
spray paint will make a lot of dust, so be sure to sand in a well ventilated area, wear
that breathing mask, eye protection, gloves, all that jazz.

Chrome spray paint

Finally, we can apply chrome spray paint to finish off the surface. Again, place the
helmet onto a bamboo stake or similar and now apply a coat of metallic chrome spray
paint. Start with a light coat and allow it to dry for an hour. Then apply a second coat
to finish it off.
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Drying

OK now its time to let the spray paint to dry for at least a day. Let the fumes dissipate
in a well ventilated area. In the next page we’ll assemble the electrics and mount
them to the helmet.

Add Electronics

Marking holes for the NeoPixel rings

Now its time for the electronics! Let’s start off with the NeoPixel rings. The 24x
NeoPixel rings should fit nicely on the indents in the ears. Place one 24x NeoPixel
ring over the left ear (or right, which ever you prefer first). Orient the ring so the
power and ground pins are pointing towards the top of the helmet. The data in pin will
point towards the bottom. This orient will keep the wires away from the front of the
visor. Get a sharp pointy thing (like a needle) and insert them through the power,
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ground and data in pins - Poke the surface to mark these points. Repeat this process
for the second ear.

Enlarge wire holes

With the pins marked, remove the 24x NeoPixel ring from the ear. Now we need to
puncture these marks and make holes that are wide enough for 26 AWG sized wires
to all through. You can heat up the tip of the needle with a lighter and push it through
these marks to create the holes. While the needle is still hot, you can move it in a
circular motion to enlarge the holes. Once the holes are made, try to pass a wire
through and see if it fits. If it doesn’t, keep widening the holes. Repeat this process for
the second ear.

Clean up holes

Once the holes are wide enough to pass wires through, you may need to remove
some excess material from the ears. You can use flush cutters remove the excess
material around each hole. Repeat this process for the second ear.
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Measure NeoPixel ring wire

Now we can measure our wires for the 24x NeoPixel ring. We recommend using
26AWG silicone coated stranded wire. We’ll need three pieces of wire for each ear.
They’ll need to be about 22mm in length. We recommend using a different colored
wire for each connection (power, ground and data in) - This helps tell them apart.
Make a second pair of wires for the second ear.

Build a Y cable

With the six wires measured and cut to length, we need to connect them together via
a “Y Cable”. Make a third pair of wires for power, ground and data in using the same
22mm length. The pairs of wires (power, ground and data in) will need to connect to
this third pair of wires, making a Y shape. Strip the ends of each wire, removing about
5mm of insulation. Tin the tips of the wires with solder, using a helping third hand to
assist you. Solder the pairs of wires together to form a Y cable. You’ll end up with set
main sets - One Y cable for power, ground and data in.
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Heat shrink

It’s a good idea to insulate the exposed connections. We can do this with pieces of
heat shrink tubing. Cut a slit half way down the piece of heat shrink and slide
it through the wire. Apply heat to shrink.

Add a second piece of heat shrink with a slit cut and overlap it onto the first piece of
heat shrink. Apply heat to shrink.
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Connect wires to 5V Trinket

Now it’s time to connect the wires to the 5V Trinket. Tin the following pins on the 5V
Trinket to make soldering easier - Ground, BAT and #0. Then  solder ground to
ground pin, power to BAT pin and data in to Pin #0. Follow the circuit diagram if you
need reference.

JST wire

Now we need to extend the power from the Trinket via a JST extension cable. Grab a
JST extension wire and cut it in half. We’ll use the end with the female JST connector
and wire it to the bottom of the 5V Trinket. Strip the tips of the two wires from the JST
extension cable and tin them. Tin the positive and negative pads on the back of the
5V Trinket and solder the JST extension cable - red to positive, black to negative.
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Build an On and Off switch

Using a second JST extension cable and a slide switch, we’ll build a JST adapter. This
will go in between the lithium polymer batter and the micro-controller. Cut the JST
extension cable in half and trim it short - about 10/20 mm in length. Solder the
negative wire from the male and female connector together and add heat shrink for
insulation. Remove the third lead from the slide switch and tin the other two. Solder
one red wire from the male connector end to one of the leads. Solder the red wire
from the female connector to the remaining lead of the slide switch. Apply heat shrink
to insulate leads from slide switch. The final JST adapter should resemble the one in
the photo. Repeat this process twice, you'll need to two JST adapters - One for the 5V
Trinket, the other for the Adafruit Feather 32u4.

Pass Y cables through ears

With the wires connected to the 5V Trinket, now its put them inside the helmet. Start
with one set of Y cables and insert each wire to one of the ears - Power, ground and
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data in. The holes should be wide enough to insert each wire. Pull wires through both
ears with so they’re about 2-3 inches long on the outside.

Connect 24x NeoPixel Rings to Y cable

Now we can connect the 24x NeoPixel rings to the wires. Secure one 24x NeoPixel to
a helping third hand. It’ll be easier to solder the wires if the pins on the 24x NeoPixel
ring PCB are tined. Move the ring close to the wires and solder power to power,
ground to ground and data to data in. Repeat this process for the second ear.

Mount 24x NeoPixel rings into ear

With the rings soldered to the wires, tug on the wires from the inside of the helmet
until the 24x NeoPixel ring is sitting flush with the ear. The wires should hold the rings
in place - You can optionally apply adhesives to permanently secure the rings in
place. Repeat this process of the second ear.
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Prep NeoPixel Strips

In this project we’re using mini NeoPixel strips - you can optionally use regular sizes
NeoPixel strips. Grab the whole strip and gauge the length you’ll need - it should span
across the length of the acrylic visor. We cut the whole length of the strip and stacked
two on top of each other - You can do this, or add more how ever you see fit. 1 meter
of strip should be enough to fit two rows as shown in the photo. Cut the NeoPixel strip
in between the three pads. Regular sized strips will have a dotted line to indicate
cutting area. The mini strip doesn't have room for this label.

Connect NeoPixel ends

Now that we’ve cut the strips to length, we need to chain them together. Position the
two strips onto a helping third hand as shown in the photo. Take note of the arrows
indicating the direction of the data stream. See how the they follow in one direction?
Make sure they’re like that - Do not have the arrows point together each other (thats
the wrong direction!). We recommend using black 30AWG silicone coated stranded
wires to connect power to power, ground to ground and data out to data in. Cut three
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pieces of wire and strip the tips, then tin. It’s easier to solder wires to the pads of the
strips when they’re tined.

Connect wires to Neo Pixel strip

Next we need to connect three pieces of wire from the NeoPixel strip to the Adafruit
Feather 32u4 Bluefruit LE. The length is variable, but it should be long enough to go
from one end of the visor to the inside of the chin. One wire for power, second for
ground and third for data in. We recommend using 26AWG silicone coated stranded
wire. Again, it’s easier to connect wires to the pads on the strip is everything is tined
(both wires and pads).

Adafruit Feather 32u4 Bluefruit LE circuit

Now we can connect the three wires from the NeoPixel strip to the pins on the
Adafruit Feather 32u4 Bluefruit LE. Tin BAT, Ground and Pin #6 on the Feather board.
Now we can connect the wires from the strip to the pins. Plug the female connector
from the second JST adapter to the lipo battery, and the male connector to the female
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connector on the Adafruit Feather 32u4 Bluefruit LE. Turn the slide switch on to see if
the circuit works! Obviously, the code should already be uploaded to both the 5V
Trinket and the Feather 32u4 Bluefruit LE.

Mount NeoPixel Strip to Acrylic Visor

Next up we need to attached the NeoPixel strip to the visor. Place the strip onto the
acrylic visor from the inside of the curvature, with the LED’s facing out - as shown in
the photo. Try to keep the strip centered and as straight as possible. To mount the
strip in place, we’re using simple scotch tape.

Install Acrylic Visor into Helmet

Now we can insert the acrylic visor into the helmet. Be very careful while doing this.
Insert the visor at an angle and slightly bend the acrylic so it can be fitted into the
lining of the visor area of the helmet. It should have a fiction fit, no adhesives are
necessary to secure the visor to the helmet, but you can optionally use some if you
find the tolerance loose.
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Prep lipo battery

OK now’s a good time to insert the two lipo batteries into our Ninjaflex lipo pockets.
You can optionally wrap gaffers tape around the lipo batteries. We recommend
applying silicone based adhesives to the ends of the wires on the lipo battery (the
area where the wires are soldered to the battery, with the kapton tape) - This helps
alleviate stress from the wires to the battery.

Mount batteries and micro-controllers

Let’s mount the batteries and micro-controllers to the inside of the helmet. A good
spot for the 5V Trinket battery is the back center of the helmet. The 5V Trinket can go
next to that. The Adafruit Feather 32u4 Bluefruit LE can go near the lower face, while
the battery can go near the bottom center of the chin. We recommend using hot glue
for the batteries and gaffers tape for the micro-controllers. The wires can also be
secured using gaffers tape. Try to keep the wires neat and tidy. There should be no
lose wires so it’s easier to put on and off the helmet.
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Test, Wear - Around The World!

Now it’s time to put on the helmet and see if everything fits! Test the circuit and see if
everything works. You can finally remove the protective film from the acrylic visor. Be
careful handling the helmet as it’s easily to scratch or scuff up the surface. Visibility is
fairly good but be cautious when wearing. Be safe, use common sense and have fun!
Congratulations on making a Daftpunk helmet!
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